
04/02/2004 

 

 
CONNECTIONS Training Project 
SUNY Training Strategies Group 

 

This material was produced under a contractual agreement with: 
CONNECTIONS Training Project 
Training Strategies Group 
Office of the Provost and Vice Chancellor of Academic Affairs 
State University of New York 
 
 

 

 
CCOONNNNEECCTTIIOONNSS  

AAddooppttiioonn  SSuubbssiiddyy  
JJoobb  AAiidd  

 



 

CONNECTIONS – Adoption Subsidy Job Aid (04/02/2004) Page 1 

CONNECTIONS – Adoption Subsidy Job Aid 
TABLE OF CONTENTS 

Introduction ................................................................................................................................. 2 

CONNECTIONS – Legacy Interface ........................................................................................... 3 
Interfaced Automated Systems................................................................................................. 3 
What is the Synchronization/Interface process?....................................................................... 3 

Adoptive Homes.......................................................................................................................... 4 
Recording Adoptive Homes in CONNECTIONS....................................................................... 4 
Progressing the Adoptive Inquiry to Applicant Status ............................................................... 8 
Submitting an Adoptive Home for Approval .............................................................................. 9 

Maintaining Adoptive Homes................................................................................................... 10 
Closing an Adoptive Home in CONNECTIONS ...................................................................... 13 

Resource Definitions ................................................................................................................ 14 

Cross-Reference Guide ............................................................................................................ 15 
 

 

 

Any visible identifying data 
in this Job Aid is simulated. 

 

 



Page 2 CONNECTIONS – Adoption Subsidy Job Aid (04/02/2004) 

Introduction 

This Job Aid provides information about recording adoptive homes in CONNECTIONS in order 
to initiate the Adoption Subsidy payment process in the Benefits Issuance Control System 
(BICS). 

Specifically, this Job Aid contains information about: 

• conducting a thorough F/A Home Search in CONNECTIONS; 

• creating an adoptive home in CONNECTIONS; 

• recording demographic information and the Vendor ID number for the home; 

• assigning the home to a worker; 

• relating people to the new adoptive home; 

• recording F/A home license information (including Facility Type); and 

• submitting an adoptive home for supervisory approval. 
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CONNECTIONS – Legacy Interface 

 
Interfaced Automated Systems 

• CONNECTIONS records all State Central Register (SCR) reports, Child Protective Services 
(CPS) intakes and investigations, foster and adoptive home development activities, contracts and 
resources. 

• CCRS (Child Care Review Service) tracks all child movements, legal events and service plans in 
the child welfare system. 

• BICS (Benefits Issuance Control System) is the system for the payment and claiming for Non-
Services cases in upstate New York. It also generates all services payments in upstate New York 
with the exception of Erie County, and generates foster care and adoption payments in New York 
City (but not for voluntary agencies in NYC). 

• WMS (Welfare Management System) records case and child demographics, eligibility data, 
purchase of service, and it authorizes services for children and families. 
 

What is the Synchronization/Interface process? 
• In August 1997, the CONNECTIONS Resource Directory and FAD dialogue were created from 

CCRS and BICS data. Facilities and providers that were known to BICS remain in BICS for 
inquiry, authorization and payment. The facilities that were in CCRS remain in CCRS for inquiry 
and placement. 

• CCRS is still used for inquiry and placement, while BICS is still used for payment and claiming. 
• Each night, a batch is run that updates WMS, CCRS and BICS with data recorded. 
• All new facilities and vendors are now recorded in CONNECTIONS. 
• For example: the interface between CONNECTIONS, CCRS and BICS updates name (and other) 

information for facilities in CCRS and the name (and other) information for all CONNECTIONS 
Resources in BICS. Historical data from CONNECTIONS updates the status of FAD homes in 
CCRS. 
 

New Entries 
and/or  

changes entered 
in FAD 

CONNECTIONS 
system 

 

New Entries 
and/or 

changes 
entered in the 

Resource 
Directory 

 
BICS  

Vendor File  
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Adoptive Homes 

Children meeting certain eligibility requirements may be able to receive federal and/or state 
adoption assistance. (For information on eligibility for Adoption Subsidy see 18 NYCRR §426.) 
This financial assistance is referred to as an Adoption Subsidy. Adoption Subsidies are 
distributed once an adoption is completely and legally finalized. 

The diagram below highlights the major milestones completed when a child transitions from 
foster care placement to a final adoptive placement. It also clearly indicates when foster care 
payment changes to adoption subsidy. 

Major Milestones in the Process of Adopting a Child in Foster Care 

 

Approval of Adoptive homes in CONNECTIONS is a separate process from the certification or 
approval of foster homes. Authorized agencies operating an adoption program have an adoption 
or home finding unit that accepts public inquiries. Once an inquiry is made, the authorizing 
agency must respond to the inquiry and develop the home as a potential adoptive placement in 
accordance with New York State adoption regulations. 

In CONNECTIONS, a Setting of “Adoption” is used to identify homes receiving Adoption 
Subsidy payments. Pre-adoptive placements (with a Setting of 
“Foster Care”) receive Foster Care Payments until adoption 
finalization. 

 

Recording Adoptive Homes in CONNECTIONS 
Creating adoptive homes in CONNECTIONS follows a very 
similar system process as that used to create foster homes. 
The key procedural differences in recording adoptive homes in 
CONNECTIONS apply to the timing of home creation and the 
Setting and Facility Type selected. 

Foster care payments and adoption subsidy payments are 
different types of payments. In order for BICS to make adoption 
subsidy payments, the Adoptive home must have a Vendor ID 
(VID) number that is different from the VID used to make foster 
care payments. 

 

The prospective adoptive parent 
inquiry will be recorded in 

CONNECTIONS twice to reflect 
the different types of payment 

each home/stage receives: 

Initially, a home is created with 
a setting of Foster Care. 

Closer to the time of an 
adoption finalization, a home is 

created with a setting of 
Adoptive Home. 

Foster Care
Payments Begin

Day 1 of
Foster Care Placement
Reunification Process Begins

Concurrent Permanency Planning Begins

TPR or Surrender
Child is Freed for Adoption

Adoption Placement Agreement is Signed
Adoptive Subsidy Home may be Created in CONNECTIONS

Pre-Adoptive Placement Begins
(child may move to a new home)
Foster Care Payments Continue

Foster Care Payments Cease
Adoption Subsidy Begins

Adoption
Finalized

Foster Care
Payments Begin

Day 1 of
Foster Care Placement
Reunification Process Begins

Concurrent Permanency Planning Begins

TPR or Surrender
Child is Freed for Adoption

Adoption Placement Agreement is Signed
Adoptive Subsidy Home may be Created in CONNECTIONS

Pre-Adoptive Placement Begins
(child may move to a new home)
Foster Care Payments Continue

Foster Care Payments Cease
Adoption Subsidy Begins

Adoption
Finalized
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In order to accommodate a second VID, a second FAD home must be created in 
CONNECTIONS with a Setting of “Adoptive” and a Facility Type of “Adoptive Home” on the 
F/A Home License window. This second home contains the Adoption Study and will be 
populated by using the Relate function to relate residents in the Foster home to the Adoptive 
home. 

 

Step-by-Step: 
Creating an Adoptive Home in CONNECTIONS 

1 On the CONNECTIONS Toolbar, click on the Options menu and select F/A Home. 
The F/A Home sub-menu displays. 

2 Click on the F/A Home Search… command from the sub-menu. 
The F/A Home Search window displays. 

3 In the Home Name field, enter the name of the adoptive parent(s) in the following 
format: Last Name,First Name(s). 
For example, “Smith,Joan” or “Smith,Joan & John”; 
do not add a space after the comma. 

4 Click on the Search… button. 
The F/A Home List displays with the results of the search. Verify that the adoptive 
home does not already exist in CONNECTIONS; if a foster home was created for 
the pre-adoptive placement, that foster home will display on the F/A Home List. 

5 Click on the New… button. 
The Home Demographics window displays. The Home Name field is pre-filled with 
the name you entered on the F/A Home Search window. 

 

6 Click on the drop-down arrow for the Setting field and select Adoptive from the 
resulting list. 

7 Record the home demographics, including Ethnicity, Race, Religion, Language 
and Marital status. 
If the adoptive home is being created at the time of adoption finalization, complete 
demographic information is needed for AFCARS reporting. 
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8 In the Primary Address section, record the primary address of the adoptive home. 

9 Click on the Validate button. 
The CODE-1 address validation message window displays. 

10 Click on the Yes button to accept the CODE-1 validated address. 
Click on the No button if the CODE-1 validated address is less complete than the 
address you recorded. For example, if you recorded the address with an apartment 
number, which the CODE-1 address validation does not return, do not use the 
CODE-1 validated address in this situation. 

11 Click on the Use as Business check box to select it, indicating that the primary 
address will be used for mailing adoption subsidy payments to the adoptive parents. 
The Vendor ID field and Validate check box enable. 

12 In the Vendor ID field, enter the unique Vendor Identification number for this home’s 
Adoption Subsidy payments. 

13 Click on the Validate button. 
The CODE-1 address validation message window displays. 

14 Click on the Yes button to accept the CODE-1 validated address. 

15 Click on the Save & Assign button. 
The Assign window displays. 

16 To save this home to your own Assigned Workload, click on the Save button. 
To assign this home to another worker, select that worker from the Available Staff list 
at the top of the window, then click on the Primary button. If the worker’s name is not 
displayed in the Available Staff list, you need to conduct a Staff Search from the 
Assign window. 
 

Once the adoptive home has been created in CONNECTIONS, you need to record person and 
licensing information for the home. 

 

Step-by-Step: 
Recording Person Information for an Adoptive Home 

1 On the CONNECTIONS Toolbar, click on the WORK button. 
The Assigned Workload displays. 

2 Click on the adoptive home you created to select it. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays. 

4 Select the Maintain Person task, then click on the List… button. 
The Person List displays. 

5 Click on the New… button. 
The Person Search window displays. 
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6 In the First and Last name fields, enter the name of the person to be added to the 
adoptive home, then click on the Search button. 
The search results display in the Person Search List at the bottom of the Person 
Search window. 

7 Click on the appropriate person’s name to select it from the Person Search List, then 
click on the Relate… button. 
The following message displays: 
“Sex mismatch between individuals. Do you wish to continue?” 
This message displays under these circumstances because you did not make a 
selection from the Sex field on the Person Search window. 

8 Click on the Yes button to close the message window. 
The Person Detail window displays. Verify that the demographic information is 
accurate. 

9 Click on the drop-down arrow for the Rel/Int field and select from the resulting list. 
If the person you are relating is the adopted child, select Child; if you are relating the 
(formerly foster, now adoptive) parents, select Parent from the resulting list. Be sure 
to relate all individuals living in the home, including biological children. 

10 Click on the drop-down arrow for the Marital field and select from the resulting list. 

11 Click on the drop-down arrow for the Religion field and select from the resulting list. 

12 Click on the drop-down arrow for the Ethnicity field and select from the resulting list. 
If you select Hispanic or Latino, you also need to select the appropriate origin(s) 
from the Hispanic or Latino Origin list box by double-clicking on an origin. Multiple 
origins may be selected. If you select Non-Hispanic or Latino, the list box disables. 

13 In the Race field, double-click to select the appropriate race(s) from the list box. 
Multiple races may be selected. 

14 Click on the Save button. 
The Person List displays. 

15 Repeat Steps 5-12 for each remaining individual who needs to be added to the 
home. 

16 When you have finished recording person information for the home, click on the 
Close button. 
The Task List displays. 
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Progressing the Adoptive Inquiry to Applicant Status 
Progressing the inquiry to Applicant status requires the completion of an adoption application. 
Applications for an adoption program are accepted on a Priority Basis, which is described below 
[18 NYCRR §421.13(a)]: 

Priority of Acceptance for Adoption Applications 

First Priority On or about April 1st of each year, OCFS will determine the age, 
race, handicap and other significant characteristics of the largest 
proportion of waiting children. First priority will be given to: 

• applicants seeking children with these characteristics; 
• foster parents seeking to adopt a child who has resided 

in their home for 12 continuous months; and 
• Native Americans seeking to adopt Native American 

children. 

Second Priority Second priority is given to: 
• applicants who are seeking to adopt photo-listed children 

who do not have the characteristics of the largest 
proportion of waiting children as determined by OCFS; 
and 

• applicants who are seeking children currently available in 
the care of the authorizing agency for whom there is not 
a waiting list of approved families. 

Third Priority Third priority is given to: 
• all other applicants (i.e., those who have expressed an 

interest in adopting children such as healthy young 
children who are not photo-listed, if such children are not 
available for adoption in the care of the authorizing 
agency where application was made). 

 

 

Step-by-Step: 
Recording Program Type and Status for an Adoptive Home 

1 From the Task List, select the Maintain Licensing Information task, then click on 
the New button. 
The F/A Home License window displays. 

2 Click on the drop-down arrow for the Facility Type field and select Adoptive Home 
from the resulting list. 

3 In the Program Type field, scroll down and double-click Regular. 
A check mark displays next to the selected Program Type. 

4 Click on the drop-down arrow for the Status field and select Applicant from the 
resulting list. 

5 Click on the Save button. 
The Task List displays. 



 

CONNECTIONS – Adoption Subsidy Job Aid (04/02/2004) Page 9 

 
 

Submitting an Adoptive Home for Approval 
The Adoptive home in CONNECTIONS does not become active 
and receive adoption subsidy payments until the adoption is 
finalized and the adoptive home has received supervisory 
approval in CONNECTIONS. Once the adoption is finalized, a 
caseworker closes the foster care case in the Welfare 
Management System (WMS) and the Child Care Review 
Service (CCRS). A new case (for the child) is then opened in 
WMS to maintain information regarding the finalized adoption 
subsidy. The Adoptive home in CONNECTIONS becomes the 
system of record for the home receiving subsidy payments. 

 

Step-by-Step: 
Recording Licensing Information and 
Submitting the Adoptive Home for Supervisory Approval 

1 From the Task List, select the Maintain Licensing Information task, then click on 
the New button. 
The F/A Home License window displays. 

2 Click on the drop-down arrow for the Status field and select Pending Acceptance 
from the resulting list. 
The Age Range and Capacity fields highlight in yellow, indicating that they are 
required fields. 

3 Click on the drop-down arrows for the Age Range fields and select the appropriate 
sex and age range for the adoptive child(ren). 

4 In the Capacity field, enter the number of adoptive children for which the home will 
receive adoption subsidy payments. 

 

Only local district workers create 
FAD Adoptive homes. 

Best practice is to create the 
Adoptive home after an 

Adoption Placement Agreement 
has been signed. 
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5 Click on the File menu and select Save and Submit. 
The To-Do Detail window displays. 

6 Click on the Save button to send the approval request to your supervisor. 
The Task List displays. 

7 Click on the Close button to close the Task List. 
The Assigned Workload displays. 

 

Once the supervisor or Unit Approver approves the adoptive 
home, its Status automatically progresses to “Accepted-Active.” 
Adoptive homes with finalized adoptive placements do not need 
to remain in Accepted-Active status in order for adoption 
subsidy payments to continue. However, the adoptive home 
must be kept updated at all times. Changes of address, family 
composition and other maintenance activities can be recorded 
by reopening a closed Adoptive home to Inquiry or Applicant 
status, correcting the information and then closing the home 
again. 

For adoptive parents with an interest in adopting more children, 
it is recommended that you maintain a home in 
CONNECTIONS with the setting type of Foster Home, a 
Facility Type of “Foster/Adoptive Home” and a status of “Accepted-Active.” This foster/adoptive 
home must be recertified/reapproved annually to remain in Accepted-Active status. The Home 
Study needs to be updated to reflect any changes. 

 

Maintaining Adoptive Homes 

Once an adoptive home has progressed to “Accepted-Active” status, it does not need to be 
reauthorized in order to continue receiving adoption subsidy payments. However, if home 
information changes (e.g., if the family moves to a new address), it is important to keep the 
adoptive home information up to date. If the home is still open, you can access the home from 
the Assigned Workload to update this information. If the home’s authorization date has expired, 
you need to use the Local Data Maintenance function (accessed via a Case Search) to make 
these changes. These maintenance processes do not affect the processing of adoption subsidy 
payments from BICS. 

 

Step-by-Step: 
Updating Primary Address Information for an Adoptive Home 
(via the Assigned Workload) 

1 From the Assigned Workload, select the adoptive home that needs to be updated. 
The Tasks… button displays. 

2 Click on the Tasks… button. 
The Task List displays. 

 

In a pre-adoptive placement, 
the home receives foster care 
payments because the child 
is still in the legal custody 

of the county. 

Once an adoption has been 
finalized, the home receives 
adoption subsidy payments. 
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3 Click on the Maintain Non-Licensing Information task, then click on the Detail… 
button. 
The Home Demographics window displays. 

4 In the Address section at the bottom of the Home Demographics window, record the 
updated address information. 
Make sure the Use as Business check box is selected; payments are sent to the 
Business address. 

5 Click on the Validate button. 
The CODE-1 address validation window displays. 

6 Click on the Yes button to accept the CODE-1 validated address. 
Click on the No button if the CODE-1 validated address is either incorrect or less 
complete than the address you recorded. For example, if you recorded the address 
with an apartment number, which the CODE-1 address validation does not return, do 
not use the CODE-1 validated address in this situation. 

7 Click on the Save button. 
The Task List displays. 

8 Click on the Close button to close the Task List. 
The Assigned Workload displays. 

9 Click on the Close button to close the Assigned Workload. 

 

Step-by-Step: 
Updating Primary Phone Information for an Adoptive Home 
(via the Assigned Workload) 

1 From the Assigned Workload, select the adoptive home that needs to be updated. 
The Tasks… button displays. 

2 Click on the Tasks… button. 
The Task List displays. 

3 Click on the Maintain Non-Licensing Information task, then click on the Detail… 
button. 
The Home Demographics window displays. 

4 In the Phone section in the lower right corner of the Home Demographics window, 
record the updated phone information. 

5 Click on the Save button. 
The Task List displays. 

6 Click on the Close button to close the Task List. 
The Assigned Workload displays. 

7 Click on the Close button to close the Assigned Workload. 
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Step-by-Step: 
Updating Address and/or Phone Information for an Adoptive Home 
(via Local Data Maintenance) 

1 Click on the CASE button on the CONNECTIONS 
Toolbar, 
The Case Search Criteria window displays. 

2 In the Case Name field, enter the name of the 
adoptive home in the following format: 
Jones,Mary 
If you know the Case ID number for the adoptive 
home, you can enter that in the Case ID field 
instead. 

3 Click on the Search button. 
The Case List displays with the search results. 

4 Locate the adoptive home on the list, then click on it to select it. 
You may need to scroll down through the list to locate the adoptive home. 

5 Click on the Summary button. 
The Case Summary window displays. 

6 Click on the case to select it from the Case Summary window. 

7 Click on the Options menu and select the Maintain Closed Person 
Demographics… command. 
The Local Data Maintenance Window displays, with the Person Demographics tab 
active. 

8 In the Primary Address Information section, record the updated address information. 

9 Click on the Validate button. 
The CODE-1 Address Validation window displays, comparing the address you 
entered with the CODE-1 validated address. All addresses recorded in 
CONNECTIONS must be run through CODE-1 Address Validation, which checks the 
accuracy of the address and formats it according to U.S. Postal Service protocols. 

10 Click on the Accept button to accept the CODE-1 validated address. 
Click on the Reject button to reject the CODE-1 validated address; this should be 
done only if the address you recorded was more complete/accurate than the 
CODE-1 validated address. 
If you recorded a NYC address and the CD (Community District code) was not 
retrieved, the following message displays: 
“Community District could not be populated.” 

11 Click on the name of the individual(s) to whom this updated address should apply. To 
select multiple individuals, hold down the Ctrl key while clicking on each person’s 
name. 

12 Click on the Save button. 
The following message displays: “Changes have been saved.” 

 

Your BFP must include the 
MAINT CLSD PERS (Maintain 
Closed Person Demographics) 
Business Function in order to 

perform this function. 
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13 Click on the OK button. 
The window refreshes and displays with the modifications. 

14 In the Primary Phone Information section, enter the updated phone Number, 
Extension (if applicable) and Type. 

15 Repeat Steps 11-13. 

16 To close the Local Data Maintenance window, click on the close button ( ) in the 
upper right corner of the window. 

 

Closing an Adoptive Home in CONNECTIONS 
An adoptive home continues to receive adoption subsidy payments until BICS is explicitly 
notified to cease payments; this occurs when the caseworker closes the WMS case file for the 
adopted child. If the Adoptive Home is still in Accepted-Active status in CONNECTIONS, you 
need to close the home in CONNECTIONS to reflect the termination of adoption subsidy 
payments. 

 

Step-by-Step: 
Closing an Adoptive Home in CONNECTIONS 

1 From the Assigned Workload, select the adoptive home that needs to be closed. 
The Tasks… button displays. 

2 Click on the Tasks… button. 
The Task List displays. 

3 Click on the Close Home task, then click on the New button. 
The Close Home window displays. 

4 Click on the drop-down arrow for the Closure 
Reason field and select the appropriate closure 
reason from the resulting list.  

5 Click on the drop-down arrow for the Closure Type 
field and select Voluntary. 

6 Click on the drop-down arrow for the Recommend 
Reopening field and select Recommend. 

7 In the Date Notification Sent field, record the date the home closure notification was 
sent to the adoptive parents. 

8 Click on the Closure Report button to generate the Closure Report. 
The report displays as a Microsoft Word document. 

9 Record information in the unprotected sections of the document. 

10 Click on the File menu and select Close. 
The Close Home window displays. 

 
Commonly Used Closure 

Reasons for Adoptive Homes 
 ►Adoption Finalized 
 ►Adoption Disruption 
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11 Click on the Save and Submit button. 
The following message displays: 
“Have you completed the Closing Summary Report?”\ 

12 Click on the Yes button. 
The To-Do Detail window displays. 

13 Enter information in the Description field, as needed. 

14 Click on the Save button to send the To-Do to your supervisor for approval. 
The Task List displays. 

15 Click on the Close button to close the Task List. 
The Assigned Workload displays. Once your supervisor approves the home closure 
in CONNECTIONS, the adoptive home will no longer display on the Assigned 
Workload. 

 

 

Resource Definitions 

Facility Any foster care home, adoptive home, or congregate care facility such as an 
institution, runaway shelter, or intermediate care facility. Foster and adoptive 
homes can be certified or approved by local districts and voluntary agencies. 
Congregate care facilities are licensed by state agencies such as NYS/OCFS, 
NYC/OMRDD and NYS/OMH. 

Provider Any resource (aside from a foster/adoptive 
home) that is paid for services. Local districts are 
responsible for recording and maintaining 
providers in the CONNECTIONS Resource 
Directory. Examples of such organizations and 
individuals that provide services for the local 
district are: 

• Day Care 
• Housing vendors (preventive) 
• Adoption vendors 

 
Providers in CONNECTIONS 

can only be maintained in 
CONNECTIONS. Only the 

district displayed as the 
maintainer for that provider 

can maintain it. 

Agency A legally incorporated entity that has the authority to provide child welfare and 
other related services. A local district (LDSS) or a voluntary agency are 
examples of an agency. 
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Cross-Reference Guide 

Below is a cross-reference guide for recording Adoptive casework activities in CONNECTIONS. 
This table identifies the casework activity and matches it to the activity required in 
CONNECTIONS. The last column provides a reference to the module in the FAD Step-by-Step 
Guide where you can find the directions for completing the activity. 

Casework Activity CONNECTIONS Activity Refer to… 

Determine if the prospective adoptive 
parent has a history of providing foster 
care services, or has had an adoptive 
home in the past. 

F/A Home Search Module 6 
 

Record inquiry information about the 
home. 

Home Demographics window Module 6 
 

Obtain and record general information 
(e.g., address, phone number, maiden 
name) about prospective adoptive parent. 

Maintain Person task Module 7 

Provide fingerprint cards and document 
information regarding the CHRC. 

Maintain Person task 
(Person Detail FA window) 

Module 7 

Document training/orientations that the 
prospective foster parent attends. 

Maintain Person task 
(F/A Home Member Training 

List/Detail window) 

Module 7 

Document the Adoption Study Narrative. Maintain Licensing 
Information task 

Module 8 

Document certification or approval 
information, track the progression of the 
home toward Accepted-Active status, and 
submit certification or approval 
information for supervisory review and 
approval. 

Maintain Licensing 
Information task 

Module 8 

Produce a Certificate or Approval Letter 
prior to the pre-adoptive placement. (The 
home will exist in CONNECTIONS as a 
foster home.) 

Maintain Licensing 
Information task 

Module 8 

Re-open an Adoption subsidy home to 
update information. 

Re-open Closed Home 
command 

Maintain Person task (update 
person information) 

Module 16 
Module 7 

Maintain changes to home and person 
information. 

Maintain Non-Licensing 
Information task 

Maintain Person task 

Module 6 
 

Module 7 

 




